
 Creating a Model 
 Now that you have a solid working knowledge of the Autodesk® Revit®

Architecture interface and you understand how it differs from most other 
drafting applications, it’s time to move on to creating the Revit model. 

 The fi rst chapter had you add some exterior walls to the model, and this
chapter will expand on that concept. You’ll also be placing some of the com-
ponents, such as doors, that were introduced in Chapter   1  , “The Autodesk 
Revit World.” Revit is only as good as the families that support the model.

 To kick off the chapter, I’ll focus on the accurate placement of interior and
exterior walls. You also have a lot to learn about the properties of walls and 
how to tackle tricky areas where the walls just won’t join together for you. 

 ▶    Placing walls 

 ▶    Using reference planes

 ▶    Adding interior walls 

 ▶    Editing wall joins 

 ▶    Placing doors and windows 

 Placing Walls 
 In Chapter   1  , you placed some walls and then added exterior walls to the 
model. In this section, you’ll add more walls to the model. Although adding
walls to the model isn’t diffi cult, you need to explore how to control these 
walls when adjacent items start moving around and corners get fussy. Also, 
I’ll present proven methods to ensure accuracy so that I can keep you from
starting down the wrong path.  

 Adding Exterior Walls
 To continue with the perimeter of the building from Chapter   1  , let’s add
some more exterior walls. The fi rst few walls you added to the model 
were pretty basic in terms of layout. It would be nice to have only square

                                                        CHAPTER   2                         
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geometry! The reality is you’re going to encounter walls at different angles and
dimensions to which you can’t just line up other walls. To get around this, you’ll 
add what are called reference planes   to help lay out the building. At the end of 
this section, your building’s perimeter will look like Figure   2.1   .  

    F I G U R E     2 . 1   :    The footprint of your completed building

 The objective of the next set of procedures is to establish some strong working
points and then add walls along those guidelines. You’ll also use these rules to 
make the necessary adjustments later in the section.

 Using Reference Planes
Reference planes   are construction lines that you can place in your model to estab-
lish centerlines and to use as an aid for symmetrical geometry. If you add a refer-
ence plane in one view, it will appear in another. If you add one in a plan view, you 
can see that same plane in an elevation or section. This approach is a great way to 
build using a common reference. Also, reference planes, by default, don’t plot. 

N O T E  Metric users should not type in mm or other metric abbreviations when 
entering amounts suggested in the exercises. Revit won’t accept such abbreviations. 
Simply enter the number provided within the parentheses. 

 The only drawback to reference planes is that they suffer from overuse. Try to
use them only as what they are: a reference. To practice using reference planes, 
follow these steps:

1.  Open the fi le you created in Chapter   1  . If you didn’t complete that 
chapter, open the fi le  NER-02.rvt  in the Chapter   2    directory, which 
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you can download from the book’s website at  www.sybex.com/go/
revit2017ner . (You can also use your own building if you choose.) 

2.  Go to Floor Plan Level 1 in the Project Browser (if you aren’t there
already).

3.   On the Work Plane panel of the Architecture tab, click the Ref Plane 
button (all the way to the right), as shown in Figure   2.2   . 

    F I G U R E     2 . 2   :    The Ref Plane command is on the Architecture tab’s Work Plane 
panel on the Ribbon.

N O T E  As you move through the exercises in this book, you’ll discover that the 
Ref Plane command is also found elsewhere in the program.    

4.  Draw the reference plane through the center of the building, extend-
ing each end past the exterior walls. (Remember, this is a construc-
tion line. You can go long if you need to do so.) See Figure   2.3    for an 
idea of where the line should go. If you’re having trouble locating the
reference points for the start of the reference plane, make sure you’re 
snapping to the midpoint of the walls. You can also type SM  to snap
to the midpoint of the wall.

    F I G U R E     2 . 3   :    You can grip-edit reference planes to the required length. 
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5.  Press Esc twice.

6.  If the line isn’t the length you want, you can stretch it. First select the
line; at each end, you see blue grips. Simply pick (left-click) the grip, and
stretch the reference plane to the desired length, as shown in Figure   2.3  . 

7.  Start the Ref Plane command again. 

8.  On the Draw panel, click the Pick Lines icon, as shown in Figure   2.4   .

    F I G U R E     2 . 4   :    Offsetting a reference plane

9.  Set Offset to 1 5 – 0  (4500  mm) (Imperial users, remember, you can
type 15 , and metric users type 4500 ), as shown in Figure   2.4  . 

10.  Hover your pointer above the mid-reference plane. A blue alignment
line appears either above or below. 

11.  Move your pointer up and down. See the alignment line fl ip? When it
fl ips to the top, pick the middle line. Doing so adds the line to the top.

12.  With the Ref Plane command still running, hover over the middle
line again. This time, offset the alignment line down. Your plan 
should now look like Figure   2.5   .

    F I G U R E     2 . 5   :    Reference planes are used here to aid in the placement of walls.
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T I P  Notice that you didn’t actually use the Offset command. Revit has the offset
function built into most of the commands you’ll be running. You just need to remember to 
look at your context tab and your Options bar, and you’ll be fine. 

 Adding More Walls 
 Let’s add some more walls. To do so, follow along with the next set of steps. (Before
you start, here’s a tip. In this procedure, you’re going to add walls in a counterclock-
wise direction, so work in that manner. But keep in mind that Revit assumes you’ll
add walls in a clockwise manner. In the future, try adding the walls clockwise; doing 
so forces the exterior of the wall to the outside.) OK, now back to adding walls:

1.  Press the Esc key twice.

2.  Select one of the exterior walls in the model, and right-click. 

3.  Select Create Similar. (You can still start the Wall command from the 
Architecture tab. If you do, make sure you select Basic Wall: Exterior –
Brick And CMU On MTL. Stud.) Create Similar is also available on the
Create panel of the Modify | Walls tab. (Metric users select Exterior – 
Brick On Mtl. Stud.) 

4.  On the Options bar, make sure Location Line is set to Finish Face: Exterior. 

5.  Start drawing your new wall from the intersection of the west wall
(the one on the left) and the upper reference plane, as shown in
Figure   2.6   . Make sure you’re using the face of the wall and not the 
ledge below. The enlargement in Figure   2.6   can help you. (Metric
users, you do not have a ledge below.)

    F I G U R E     2 . 6   :    Drawing a single wall from a defined starting point
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6.  If the wall is starting on the wrong side of the reference plane, tap
your spacebar to fl ip the wall to the correct side.

7.  Making sure you have a horizontal line started, type  25  (7500  mm), 
and press Enter.

8.  Press Esc. 

9.  Do the same for the other side. Your plan should now look like
Figure   2.7   . 

30
'–
0"

25'–0"

    F I G U R E     2 . 7   :    The two walls drawn here are 30  (9000 mm) from inside finish 
face to inside finish face. 

10.  Start the Wall command again if it isn’t already running. Make 
sure the Chain check box is selected. This will allow you to keep 
drawing walls continuing from the last point of the previously 
drawn wall.

11.  From the top 25  (7500 mm) wall, pick the corner of the fi nish face 
(again, the brick face and not the ledge below). The wall may be posi-
tioned in the wrong orientation, so tap the spacebar to fl ip it if it is.

12.  Move your cursor up and to the left at a 135° angle (Revit snaps at 45° 
intervals).

13.  When you move your cursor far enough in this direction, Revit picks 
up the north fi nish face of the building drawn in the previous proce-
dure. After these two alignment lines appear, pick the point on the 
screen, as shown in Figure   2.8   .
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14.  Draw a horizontal wall to the left 25  (7500 mm).

15.  From the left point of that wall, draw a wall up 25  (7500 mm). 

16.  From the top of that wall, draw another wall to the left 80
(24000 mm). 

17.  Draw a wall down 25  (7500 mm).

18.  On the Modify | Place Wall panel, click the Start-End-Radius Arc but-
ton, as shown in Figure   2.9   .

    F I G U R E     2 . 8   :    Allow Revit to guide you in the placement of walls. 

    F I G U R E     2 . 9   :    Draw a radial wall using the Start-End-Radius Arc method.

19.  Because the Wall command is still running, the next point to pick is
the endpoint of the arc. Before you do that, you will have to hit the 
spacebar to fl ip the wall in the correct orientation. 

20.  Pick a point straight down at a distance of 30 –0  (9000 mm).

21.  Move your pointer to the right until Revit snaps it to the tangent
radius. (You may not get a tangent snap, but Revit will hesitate when 
you’ve reached the tangency.) After this happens, pick a point.
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22.  On the Draw panel, click the Line button in the upper-left corner.
This will allow you to draw a straight wall again. 

23.  Hit the spacebar if the wall is in the wrong orientation. 

24.  Draw a wall straight down from the end of the arc 25  (7500 mm).

25.  Draw a wall to the right 80  (24000 mm). 

26.  Draw a wall straight up 25 –0  (7500 mm).

27.   Press Esc. Your building should look like Figure   2.10   .

    F I G U R E     2 . 1 0   :    The building up to this point 
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28.  Start the Wall command if it isn’t running already or click one of the
walls you already placed, and select Create Similar (that’s what all the 
cool kids are doing). 

29.  On the Draw panel, click the Pick Lines icon, as shown in
Figure   2.11   .

       If you’re having trouble 
sketching the outline, 
remember to slow down. 
The next few walls will
be a little tougher. You’ll 
have to place them using 
the embedded off set
function within the Wall 
command.

▶
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30.  On the Options bar, you’ll see an Offset input. Type 30  ( 10000  mm), 
and press Enter.

31.  Move your cursor over the outside face of the wall, as shown in
Figure   2.12   . When you see the alignment line appear below the wall,
pick the outside face. 

    F I G U R E     2 . 1 1   :    The Pick Lines icon lets you add a wall by using an offset from 
another object.

    F I G U R E     2 . 1 2   :    Adding a wall using the built-in offset function may take a few 
tries to get the method down.

32.  Repeat the procedure for the angled wall. Make sure you offset the
wall to the left (see Figure   2.13   ). 

33.  Click Modify.            
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 Cleaning Up Using Trim

 So, it’s kind of a mess! It would be cool if Revit joined these walls the way you 
want, but that would, I’m afraid, be too much to ask. Sometimes it does, but
sometimes it does not. By using the Trim command, you can clean up those 
overlapping corners and fi ll the gaps by simply selecting the walls you want
joined together. There’s one major thing to remember here. Select the walls on 
the side you want to keep, not the side you want to trim away.

 To get started, follow these steps: 

1.   On the Modify tab, select the Trim button on the Modify panel, as 
shown in Figure   2.14   . 

    F I G U R E     2 . 1 3   :    Creating the bottom of the corridor

    F I G U R E     2 . 1 4   :    The Trim command is your new best friend. 
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ashioned Shortcuts       Old-Fa
 Notice when you hover over the icon you see two letters in parentheses like this: 
(TR). This indicates you can type TR  as a keyboard shortcut. 

2.   The next step is to select the walls in the sequence and in the spots
shown in Figure   2.15   .

 Your walls should look like Figure   2.16   .  

    F I G U R E     2 . 1 5   :   Using the Trim command to join the corners 

    F I G U R E     2 . 1 6   :    The walls are now clean.
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3.  You should add another part of the building. It’s going to be a simple
U-shape on the south end of the building. Select and right-click one 
of the exterior walls. Then, click Create Similar.

4.  On the View toolbar, set the detail level to Coarse, as shown in
Figure   2.17   . 

    F I G U R E     2 . 1 7   :    Sometimes setting the graphic display to Coarse can make the
placement of other walls easier.

5.  On the Options bar, change Offset to 15 –0  (4500  mm). 

6.  Pick the midpoint of the south wall, as shown in Figure   2.18   .

    F I G U R E     2 . 1 8   :    Adding the new walls requires picking the midpoint of this 
wall. Make sure Offset is set to 15 –0  (4500 mm) on the Options bar.

7.  Draw the wall 25  (7500 mm) down from the south wall by typing 25
(7500  mm) and pressing Enter.
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8.  After you pick the 25  (7500 mm) distance, move your cursor up, back 
toward the wall, as shown in Figure   2.19   , resulting in a 25 -long (7500
mm) wall. 

    F I G U R E     2 . 1 9   :    By using the Offset command as you draw walls, you can use
one common centerline.

9.  Set Offset to  0 . Draw a wall across the front of the two walls, as shown 
in Figure   2.20   . Make sure it’s fl ipped in the right direction. You can
determine this by switching back from Coarse to Fine detail. Click
Modify.          

    F I G U R E     2 . 2 0   :    The completed walls for the south side of the building

 Your walls should look like Figure   2.20  . 
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t Measure Up?        Does It
 In Revit, you can access the Measure function, which is the same as the Distance 
command in Autodesk® AutoCAD® software. To verify whether your walls are 
placed at your chosen distances, click the Measure icon as shown here. After you 
measure the distance, the Options bar will show you the result. The Measure icon 
is also available on the Measure panel of the Modify tab.    

 Adding Interior Walls
 Interior walls are basically the same as exterior walls in terms of how they’re
placed in the model. This is a good thing. Luckily, you can be slightly more
relaxed with the justifi cation. Now that the building has a footprint, you can see 
more easily whether the walls need to be adjusted.

 You’ll start by laying out an elevator shaft and a stairwell, using an 8  (200 mm)
CMU wall system. Follow these steps: 

1.  Open or make sure you’re in Floor Plan Level 1. Zoom into the north-
east corner of the building, as shown in Figure   2.21   .

2.  On the Architecture tab, click the Wall button. 

3.  In the Type Selector, select Generic – 8  Masonry, as shown in Figure
  2.21  . (Metric users use the Generic – 225 mm Masonry wall.) 

4.  For the starting point, pick the corner as shown in Figure   2.21  . The 
wall will probably be in the wrong orientation, so if necessary, tap the
spacebar to fl ip the wall’s orientation.

5.  Move your cursor downward, and type  12  (3600  mm). The wall will
be 12  long.

6.  Move your cursor to the right, and type 10  (3000  mm).
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    F I G U R E     2 . 2 1   :    Start drawing the 8 (200 mm) CMU elevator shaft in the
corner indicated here. Turn on Thin Lines if you need to.

    F I G U R E     2 . 2 2   :   The elevator shaft begins to take shape. 

7.  Move your cursor back up the view, and pick the exterior wall.

8.  Click Modify. You should have three walls that look like Figure   2.22   .     
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 At this point, you have some walls in the model. It’s time to look at ensuring 
that these walls are accurately placed, so you need to check the dimensions.

 Using Temporary Dimensions to Gain 
Control of Your Model
 After you place items in a model, you usually need to make some adjustments.
Revit does a good job with this; however, there are some rules to which you need
to adhere. The goal here is to have a clear 10 –0  (3000 mm) dimension on the 
inside faces of the shaft. At this point, you should assume that you don’t. This is 
where temporary dimensions come into play. To start working with temporary 
dimensions, follow these steps:

1.  Select the right, vertical CMU wall. A blue temporary dimension 
appears, as shown in Figure   2.23   . 

    F I G U R E     2 . 2 3   :    Temporary dimensions can be adjusted to measure from 
different wall faces by picking the witness-line grip. 

2.  On the temporary dimension, you see some blue grips. If you hover 
your cursor over one of them, a tooltip appears, indicating that this 
grip represents the witness line.
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3.  Pick the grip to the right side of the dimension. Notice that it moves 
to the outside face of the wall. Pick it again, and notice that it moves
to the inside face. This is exactly where you want it.

4.  The actual increment in the dimension is blue. Select the blue
dimension, type 10  (3000  mm), and press Enter. The wall that was 
selected moves to accommodate the new increment, as shown in
Figure   2.24   .

    F I G U R E     2 . 2 4   :    The selected wall is the wall that will move when you type the 
new dimension. 

 Temporary Dimension Settings 

 Revit measures the default dimension for the temporary dimensions from the
center of the walls, which is typically the last place from which you want to take
the dimension. You can change some settings to fi x this action.

1.  On the Manage tab, click Additional Settings ➢ Temporary 
Dimensions, as shown in Figure   2.25   .

2.  In the Temporary Dimension Properties dialog box, select Faces in
the Walls group. 
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3.  In the Doors And Windows group, select Openings, as shown in
Figure   2.26   .

    F I G U R E     2 . 2 5   :    The Temporary Dimensions function lets you control where 
Revit measures the temporary dimensions. 

    F I G U R E     2 . 2 6   :    The most popular configuration for temporary dimensions
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4.  Click OK.

5.  Select the south, horizontal wall. 

6.  To the right of the dimension, you see a small blue icon that also
looks like a dimension. If you hover your mouse over it, a tooltip
appears, indicating that you can make the temporary dimension per-
manent, as shown in Figure   2.27   . When you see this tooltip, click the 
icon. 

    F I G U R E     2 . 2 7   :    You can make temporary dimensions permanent. 

7.  Press Esc. 

8.  Select the same wall again. Notice that the permanent dimension
turns blue. You know that anything that turns blue in Revit can be
edited. You can change this increment any time you wish.

9.  Change the dimension to  12  (3600  mm), and click out of the dimen-
sion text. The wall moves into position, and the dimension is now an 
even 12  (3600 mm).

 You need one more shaft wall to create a separation between the exterior walls 
and the shaft, as shown in Figure   2.28   . Perform these steps: 

1.  Select any CMU wall, and click Create Similar.

2.  On the Draw panel, click the Pick Lines icon. 
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3.  On the Options bar, type  10  ( 3000  mm) in the Offset fi eld. 

4.  On the Options bar, be sure Location Line is set to Finish Face: Interior.

    F I G U R E     2 . 2 8   :    The shaft wall 

5.  Offset the south CMU shaft wall (from the inner line). Doing so sepa-
rates the shaft from the exterior and creates a little chase.

6.  Press Esc twice. Figure   2.28   shows the shaft wall. Make sure that you
check your dimensions before proceeding.

 The next task is to mirror these walls to the other side.

1.  Pick a window around all the masonry walls (a window with your cursor,
not an actual window). 

2.  On the Modify | Walls tab, click the Mirror ➢ Pick Axis button, as
shown in Figure   2.29   . 

    F I G U R E     2 . 2 9   :   The Mirror ➢ Pick Axis command is activated when you have
objects selected.
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3.  Pick the horizontal reference plane in the center of the building. Your 
walls are now mirrored, as shown in Figure   2.30   .

    F I G U R E     2 . 3 0   :    The elevator shaft is now mirrored.

4.  Save the model.     

 You’re starting to get the hang of adding different wall types—but you aren’t
fi nished yet. You still need to add quite a few interior partitions. 

ou Select Too Much?        Did Yo
 If you picked a window around all of your walls and have more items selected 
than you want, you can press the Shift key on your keyboard and pick the item(s) 
you want to deselect. Doing so removes the item from the selection set. If the 
opposite happens and you want to add an item, press the Ctrl key and pick the 
item(s) you want to add. Your cursor will always appear with a plus or a minus 
sign, as shown here:    
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 Placing Interior Partitions

 The majority of your tasks in Revit involve placing interior partitions. Given the 
dimensional nature of placing these types of walls in Revit, you don’t need to 
bother with reference planes as often as when you place the exterior walls.

 Knowing that, creating interior partitions is somewhat easier than creating 
the exterior variety. With the exterior type, you must place partitions carefully,
and constant double-checking is crucial. With interior partitions, you can typi-
cally get the wall where you think you need it. You can then go back and make
adjustments without disturbing too many adjacent items. Not that you have to
do it this way—you can be accurate to begin with—but life is all about second
chances! 

 To start adding interior partitions, you’ll add the necessary lavatories and 
egress and then fi ll the spaces with offi ces. When completed, this stage will look
like Figure   2.31   .  

    F I G U R E     2 . 3 1   :    The east side of the building with egress and lavatories 

 The objective of the next procedure is to begin adding interior partitions. 

1.  Make sure you’re on Floor Plan Level 1.

2.  On the Architecture tab, click the Wall button. 

3.  In the Type Selector, select Interior – 6 1⁄8  Partition (2-hr) (Interior – 
135 mm Partition (2-hr)). 

4.  For Height, choose Level 2 from the menu (if it isn’t already the cur-
rent selection). 

5.  For Location Line, choose Finish Face: Exterior.



 A d d i n g  I n t e r i o r  W a l l s 6 7

6.  On the Draw panel, click the Start-End-Radius Arc button (upper 
right in Figure   2.32   ).

    F I G U R E     2 . 3 2   :    Choosing options should be old hat by now! The Start-End-
Radius Arc button is at the upper right on the Ribbon.

    F I G U R E     2 . 3 3   :    Drawing an arched radial wall requires a three-point method.
It’s similar to the Start-End-Direction command in AutoCAD.

7.  Pick the lower-left corner of the upper CMU walls.

8.  Pick the upper-left corner of the bottom CMU walls.

9.  Move your cursor to the left, and specify a radius of  20 –0  (6000  mm), 
as shown in Figure   2.33   . 

10.  Press Esc twice.
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 You now need to add some corridor walls. You can do this using the center
reference plane you established earlier. 

1.  If you aren’t still in the Wall command, select and then right-click
the radial wall, and then select Create Similar.

2.  On the Draw panel, click the Line button. 

3.  For Location Line, choose Finish Face: Interior.

4.  For Offset (on the Options bar), add a 4 – 0  (1200  mm) offset. 

5.  To start placing the wall, pick the intersection or endpoint of the cen-
ter reference plane and the radial wall, as shown in Figure   2.34   .

    F I G U R E     2 . 3 4   :    Drawing corridor walls using an offset can be a great 
time-saver. 

6.  Move your cursor to the left. Notice that the wall is being drawn but 
at an offset of 4 –0  (1200 mm) from the “line” you’re drawing up the 
middle of the building (if it’s in the opposite direction from what’s
shown in Figure   2.34  , tap the spacebar to fl ip it).

7.  For the second point of the wall, pick the intersection or endpoint of 
the vertical wall to the left.

8.  Move your cursor back to the right. Notice that the other side of the 
wall is being drawn at a 4 –0  (1200 mm) offset. This time, it’s on the 
opposite side of the reference line.

9.  Pick the intersection of the reference plane and the radial wall as the
second point, as shown in Figure   2.35   .
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 Let’s clean up the gaps between the radial wall and the two corridor walls.

1.  Make sure you aren’t still in the Wall command by pressing Esc twice
or by clicking the Modify button to the left of the Ribbon. 

2.  Select the top corridor wall. On the right end of the wall is a blue 
grip. Pick it, and drag the top corridor wall into the radial wall.

3.  Repeat the step for the bottom wall (see Figure   2.36   ).    

    F I G U R E     2 . 3 5   :    Completing the main corridor. You’ll still have to drag the walls
together to join them.

    F I G U R E     2 . 3 6   :    Getting a grip on the grips
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 The next step is to add the lavatories. These will show up at the west end (left
side) of the building. Refer to Figure   2.37    for the dimensions, and follow these 
steps:

1.  Select and then right-click one of the corridor walls, and select Create 
Similar from the menu. 

    F I G U R E     2 . 3 7   :    The lavatories at the west side of the building 

2.  Look at your options, and create the lavatories shown in Figure   2.37  . 
All of the dimensions are taken from the inside fi nish face.

3.  After you draw in the lavatory walls, mirror the walls to the other side
of the building, as shown in Figure   2.38   .

W A R N I N G  Picking a grip on the end of a wall also means that you get a 
temporary dimension. Look at it! If it doesn’t say 8 –0  (2400 mm) to the inside face of 
the corridor, you have a problem. It ’s much better to discover these discrepancies early 
in the design stage than to find out that you have a dimensional issue when the draw-
ings are going out the door. If the increment isn’t 8 –0  (2400 mm), first verify that the
temporary dimension is going to the inside face. If not, pick the blue grip and move the 
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witness line to the inside face of the walls. If the dimension is still off, move the witness 
line to the center reference plane. Now type  4  ( 1200 mm), and press Enter. Repeat the 
process for the other wall. Always check dimensions like this. The time you save could be 
your own!   

    F I G U R E     2 . 3 8   :    Both the men’s and women’s lavatories 

 You now need another corridor running north and south, as shown in Figure
  2.39   . The best way to approach this task is to add another reference plane and
then add the walls in a fashion similar to the method applied to the east/west 
corridor. To open the central area, you’ll add 45° walls at 4 –0  (1200 mm).
Follow these steps to add the new walls: 

1.  On the Work Plane panel of the Architecture tab, click Ref Plane.

2.  Draw a reference plane from the midpoint of the top exterior wall to 
the midpoint of the bottom exterior wall.

3.  Click the Measure Between Two References button. Make 100 percent 
sure that this is the center of the building. You’re going to rely heav-
ily on this line.

4.  Start the Wall command. 

5.  On the Options bar, be sure Location Line is set to Finish Face: 
Interior and that Offset is 4 –0  (1200 mm).
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6.  Pick the top intersection or endpoint of the reference plane and the 
exterior wall.

7.  Draw the wall down to the bottom of the building.

8.  Keeping the Wall command running, draw the other side of the cor-
ridor by picking the same two points along the reference plane. When
you’re fi nished, press Esc.

T I P  Are the reference planes really necessary? No, they aren’t. But using them
is a good, sound approach to laying out your building. These lines will be used heavily 
throughout the life of your project.   

 You’ve created an area in the middle of the building where four walls intersect
each other. You can now add 45° walls there to open the corridor at this area, as 
shown in Figure   2.40   . 

1.  Zoom into the intersection of the corridors.

2.  On the Architecture tab, click Ref Plane on the Work Plane panel.

3.  On the Draw panel, click the Pick Lines button, and change Offset to 
4 –0  ( 1200  mm).

    F I G U R E     2 . 3 9   :    This is the finished corridor layout. 
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4.  From the fi nish inside face of the top, horizontal corridor wall, offset
the reference plane up (see Figure   2.41   ).

    F I G U R E     2 . 4 0   :    The corridor with the 45° walls added

    F I G U R E     2 . 4 1   :    Adding yet another reference plane to the model. You’ll delete
this one.

T I P  It can be tricky to get the reference plane going in the correct direction. If the
reference plane is being stubborn and is still trying to offset the line down, move your 
cursor up a little. The reference plane will change direction.   
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 After you establish the reference plane, you can add the new wall. It can be as
simple as drawing the wall in, but there are still a few little procedures of which 
you should be aware.

1.  Start the Wall command. 

2.  On the Options bar, be sure the wall’s Location Line is justifi ed from
Finish Face: Exterior. 

3.  Pick the intersection of the reference plane and the inside fin-
ished face (right face) of the left, vertical corridor wall (see
Figure   2.42   ).

    F I G U R E     2 . 4 2   :    Adding the 45° wall 

4.  After you pick the start point, move your cursor to the left and down 
at a 45° angle. (You can approximate the angle; Revit will snap you to
the correct angle.) 

5.  At a 45° angle, pick the endpoint at a location within the horizontal,
top corridor wall. When you’re fi nished, press the Esc key twice. You 
may have to press the spacebar to get your wall fl ipped in the proper
direction, as shown in Figure   2.42  .    

W A R N I N G If you proceed with assuming that these walls are a specif ic 
increment (4  [1200 mm]) from the inside face, you may be making a big mistake. Take
distances after you add walls, especially if the walls aren’t 90°.   
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 The next task is to mirror the walls. This part will be easy because you put in
those reference planes. 

1.  Select the 45° wall.

2.  Pick Mirror Pick Axis from the Modify | Walls tab.

3.   Pick the vertical reference plane, and  voilà  ! The wall is mirrored, as 
shown in Figure   2.43   .

    F I G U R E     2 . 4 3   :    Using the Mirror command in conjunction with a reference
plane is a good example of thinking ahead.

lling with Accuracy        Eyebal
 You may notice that when you’re using temporary dimensions, the increment 
always seems to snap to even increments. This is no accident. If you click the 
Snaps button on the Manage tab, you’ll see values for Length Dimension Snap 
Increments and Angular Dimension Snap Increments. These values change based 
on the zoom percentage. The closer you zoom in, the smaller the increments get. 

(Continues)



7 6  C h a p t e r  2  •  C r e a t i n g  a  M o d e l

lling with Accuracy     Eyebal (Continued) 
You can also add to these values by typing a semicolon and adding a new increment 
to the end of the list, as shown here: 

4.  Select the two 45° walls, and mirror them around the horizontal
reference plane. You should now have four 45° walls, as shown in
Figure   2.44   . 

5.  Delete the temporary horizontal offset reference plane by selecting it 
and pressing the Delete key on the keyboard.     
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 Now it’s time for some further cleanup. Although all the modify commands 
will be featured in Chapter   4  , “Working with the Autodesk Revit Tools,” you can
still use some here. You’ve already borrowed the Mirror command from that
chapter. You might as well borrow the Split command too. 

1.  On the Modify panel of the Modify tab, click the Split Element but-
ton, as shown in Figure   2.45   . 

    F I G U R E     2 . 4 4   :    Stuck inside these four walls 

    F I G U R E     2 . 4 5   :    Using the Split Element command

2.  Always look at the Options bar! Select the Delete Inner Segment
option. 

3.  Pick a point along the top horizontal corridor wall near the intersect-
ing 45° wall. 

4.  Pick the second point along the same wall, only on the opposite side 
(see Figure   2.46   ). 
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5.  Repeat the process for the other three walls. You should now have an 
open central area for your corridor, as shown in Figure   2.47   .      

    F I G U R E     2 . 4 6   :    Split the wall at two points. If you’ve selected Delete Inner 
Segment, the result is to eliminate the wall between the two points.

    F I G U R E     2 . 4 7   :    The open corridor
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N O T E If the Split Element command is giving you a splitting headache rather
than splitting the walls, keep trying. I’ll also cover this in Chapter 4. Commands such as 
Split Element require a different touch than the AutoCAD Break command.

Looking back, you’ve accomplished quite a bit. Laying out walls and then
modifying them to conform to your needs is a huge part of being successful in 
Revit, but you aren’t fi nished. The next few processes will involve dealing with
different types of walls that merge together. Historically, merging walls has been 
an issue in modeling software. Although Revit tends to clean up these areas a 
little better than other modeling applications, you must still cope with some
sticky areas. Let’s create a sticky situation!     

 Editing Wall Joins 
 A separate function in Revit deals with editing wall joins—specifi cally, the Edit 
Wall Joins command, which can come in handy. To get started, let’s add more
walls to an already busy corner of the building. 

1.  Zoom into the northeast corner of the building, as shown in
Figure   2.48   , and set the detail level to Fine.

    F I G U R E     2 . 4 8   :    The northeast corner

2.  Start the Wall command. Make sure it’s the same 6 1⁄8  (135 mm)
two-hour partition you’ve been using.

3.  With the Chain button off and Location Line set to Finish Face:
Exterior, to start the wall, pick the intersection where the CMU wall
abuts the inside fi nish face of the exterior wall (see Figure   2.49   ).
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Again, you can turn on Thin Lines to get a better view of what you’re 
seeing.

    F I G U R E     2 . 4 9   :    Adding to the mess in the corner 

4.  The wall may be fl ipped in the opposite direction from Figure   2.50   . 
If it is, remember to press the spacebar; doing so fl ips it up to the 
proper orientation. 

    F I G U R E     2 . 5 0   :    The wall and the resulting intersection

5.  Pick the second point of the wall at the corridor in the middle of 
the building. Press Esc twice. The intersection should look like 
Figure   2.50  . 

6.  Zoom back in on the intersection. If the view doesn’t resemble Figure 
  2.50   in terms of line weight, click the Thin Lines icon, as shown in
Figure   2.51   .
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7.  On the Geometry panel of the Modify tab, click the Wall Joins button,
as shown in Figure   2.52   . 

    F I G U R E     2 . 5 1   :    Click the Thin Lines icon to see how the walls are joining together. 

8.  Hover your pointer over the intersection. Revit displays a big box, as
shown in Figure   2.53   . 

    F I G U R E     2 . 5 2   :    You’ll find the Wall Joins button on the Modify tab.

    F I G U R E     2 . 5 3   :    Choosing the intersection you want to edit
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9.   Pick anywhere within the area. Doing so establishes that this is the
intersection you want to edit. 

 After you pick the intersection, some additional lines appear. These 
lines expose how Revit is actually looking at the corner.  

10.  On the Options bar, you now see some choices for confi guring this
intersection. Select the Miter option, as shown in Figure   2.54   . This
option is the most popular. Click Modify.          

    F I G U R E     2 . 5 4   :    Adding a mitered join

 Although a wall of this type would never have a 45° miter in real life, mitering
the corner in Revit allows for a more uniform join between adjacent walls.

 Displaying Wall Joins
 Usually, in a plan view such as this, no wall joins are shown. Typically only the 
outside lines join, and an enlarged detail would show the specifi c construction
methods. But in some cases, you want Revit to reveal this information. In Revit, 
you have two choices for the display (Figure   2.55   ).
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Clean All Wall Joins This option joins together the same materials in each 
wall, regardless of the wall type.

Clean Same Type Wall Joins  Stating the obvious, this option clean joins only
within walls of the same type. 

    F I G U R E     2 . 5 5   :    Choosing a display option 

 The objective of the next procedure is to identify the difference between wall
join types. 

1.  Zoom in on the northwest corner of the east addition, as shown in
Figure   2.56   . 

2.  Make sure Detail Level is set to Coarse.

3.  In the Properties dialog, change Wall Join Display to Clean Same
Type Wall Joins. 
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4.  Observe the difference between the wall joins, as shown in
Figure   2.56  . 

5.  Save the model.      

    F I G U R E     2 . 5 6   :    Choosing a Wall Join Display option in the view’s properties

 Disallowing Wall Joins 
 You must deal with another important item when walls join together. In some
cases, you may not want walls to join automatically even if they’re the same wall 
type. To learn how to prevent this behavior, follow these steps: 

1.  Change Detail Level to Fine.

2.  Select the long, horizontal 6 1 ⁄8  (156 mm) wall that comes into 
the corner, as shown in Figure   2.57   . A blue grip appears to the right
of the intersection. This represents where the wall’s extents are 
located.
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3.  Hover directly over the blue grip. 

4.  After the blue grip highlights, right-click.

5.  Select Disallow Join (see Figure   2.57  ).

    F I G U R E     2 . 5 7   :    By right-clicking the wall’s end grip, you can tell Revit to 
disallow that wall’s join function.

6.  When the wall is unjoined, you can pick the same blue grip and slide 
the wall back to where you want it to terminate (see Figure   2.58   ).

7.  After the wall slides into place, select it (if it isn’t already selected).

8.  Notice that there is an additional blue T-shaped icon. Hover your cur-
sor over this icon; click it to allow the walls to join back up, as shown
in Figure   2.59   .
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 As mentioned earlier, your ability to edit wall joins can determine how quickly 
you start either liking or disliking Revit. This book took a few extra steps in the
effort of joining walls, but the experience will carry through, project after project.

    F I G U R E     2 . 5 8   :    Slide the wall back to abut the adjacent wall.

    F I G U R E     2 . 5 9   :    Allowing the walls to join back up again 
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 We need to investigate one more area before we leave this corner: the area
within the chase. Suppose you don’t want to run the gypsum into this area. This 
is a common situation that can cause people to have fi ts with Revit. Let’s try to 
avoid those fi ts right now!

 Editing the Cut Prof ile 

 A plan view is simply a section taken 4 –0  (1200 mm) up the wall from the fi n-
ish fl oor. In Revit, you can manually edit the profi le of any wall cut in plan. This 
is extremely useful if, for example, you need to take sections of drywall out of 
specifi c areas without creating or adding an entirely new wall. To do this, per-
form the following steps:

1.  Zoom in on the right side of the elevator shaft at the intersection of 
the exterior wall, as shown in Figure   2.60   . 

2.  Select the east CMU wall, and right-click the blue grip on the end-
point of the wall. 

3.  Select Disallow Join (see Figure   2.60  ). 

4.  Pick the blue grip, and drag the wall end back to the face of the wall
behind the gypsum. 

5.  On the Graphics panel of the View tab, click the Cut Profi le button, as 
shown in Figure   2.61   . 

    F I G U R E     2 . 6 0   :    Pull the CMU out of the wall, disallow the join, and then drag it 
back into the face of the stud.
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6.  Pick the fi nish face of the exterior wall. You’re selecting the gypsum
layer to be cut out of the shaft. 

7.  You now need to draw a very short, vertical line from the inside face 
of the wallboard to the outside face, as labeled 1 and 2 in Figure   2.62   . 
Press Esc. 

8.  When the short line is drawn in, you see a blue arrow. This arrow
indicates the side of the material you want to keep. If you pick the
arrow, it fl ips direction. Make sure it’s pointing to the right.

    F I G U R E     2 . 6 1   :    Click the Cut Profile button, and select the gypsum.

    F I G U R E     2 . 6 2   :    This line indicates where the wallboard will be cut. The blue
arrow indicates the side of the material that will remain.
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9.   What you see here is called Sketch Mode. Because you’ve fi nished 
sketching the cut profi le, click Finish Edit Mode, as you can see in
Figure   2.63   . Figure   2.64    shows the fi nal result.

    F I G U R E     2 . 6 3   :    Clicking Finish Edit Mode finalizes the session and completes 
the command.

N O T E  If you receive an error that says “Ends of the sketched loop don’t lie on the
boundary of the face being modified” when you’re trying to finish the sketch, it’s because 
you haven’t drawn the line exactly from point to point. This line can’t cross over, or be shy 
of, the material you’re trying to split. If you’re getting this error, select the magenta line. 
You’ll see two familiar blue grips. Pick the grip that doesn’t touch the face of the material, 
and drag it back.   

    F I G U R E     2 . 6 4   :    The finished wall with the drywall deducted from the core of the chase 

 Go through and do the same thing to the south side of the building, starting
at the Edit Wall Joins section.
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 There are many more walls left to add, but we need to save something for
Chapter   4  . At this point, it sure would be nice to start adding some doors and 
windows to the model.     

 Placing Doors and Windows 
 Adding doors and windows is one of the easiest things you’ll do in Revit. Finding 
the correct door or window becomes a bit harder. Creating a custom door or 
window takes time and patience. In this section, you’ll focus on adding these
items to the model. Chapter   16  , “Creating Families,” will drill down into the
specifi cs of creating custom families.  

 Adding Doors 
 Placing a door in Revit can seem annoying and unnecessarily tedious at fi rst.
But like anything else in Revit, once you get the method down, you’ll fi nd your
groove. Follow these steps:

1.  Make sure you’re in Floor Plan Level 1.

2.  On the Architecture tab, click the Door button (see Figure   2.65   ). 

    F I G U R E     2 . 6 5   :    Adding a door

3.  Make sure the Tag On Placement button is highlighted, as shown in
Figure   2.66   .

4.  In the Type Selector, choose Single-Flush: 36  × 84  (M_Single-Flush 
0915 mm × 2134). 

5.  Move your cursor over to the south wall near the elevator shaft, as 
shown in Figure   2.66  . Notice that if your cursor isn’t within a wall,
you get the NO sign. Revit won’t allow you just to place a door into 
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6.  After you get your cursor positioned approximately where Figure   2.66   
shows it, move your pointer up and down. Notice that the door’s direc-
tion changes. This is typical behavior for a door. 

7.  Press the spacebar. The door swing fl ips direction.

8.  Make the door face outward and to the left, as shown in Figure   2.66  .
Then pick a point on the wall. If you accidentally put it in wrong,
don’t worry—you can fi x it.

    F I G U R E     2 . 6 6   :    Placing a door always requires a host. Remember, you can 
press the spacebar to change the orientation and move your cursor up and down to flip 
the direction. 

space; a door is considered a hosted family and needs a wall into
which it must be embedded.
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Look at My Walls!       Yikes, 
 When you place a door or any opening into a compound wall, you need to tell 
Revit specifically how to wrap the materials. By default, Revit will stop the brick 
and any other finish right at the opening. Obviously, this usually isn’t correct. The 
following steps guide you through wrapping materials at an insert: 

1.  Select the exterior wall. 

2.  In the Properties dialog, click the Edit Type button, as shown here:

3.  In the drop-down menu that specifies Wrapping At Inserts, select Both.

4.  Click OK.     

 Notice that when the door is placed, a tag appears with an automatic num-
ber. This happens when Tag On Placement is activated on the Tag panel in the
Modify | Place Door tab. In Revit, after you place a door you should press Esc
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twice and then go right back and select the door. Doing so highlights the door
and activates a few different options. Follow these steps: 

1.  Click the Modify button at left on the Ribbon. Doing so disengages 
you from the Door command. 

2.  Pick the door you just added to the model. Notice the blue temporary
dimensions. Let’s make sure these dimensions are going where you
want them.

a.  On the Settings panel of the Manage tab, click Additional 
Settings ➢ Temporary Dimensions, as shown in Figure   2.67   . 

b.  Make sure that Wall Dimensions are going to Faces and that
Door Dimensions are going to Openings. 

c.  Click OK.

    F I G U R E     2 . 6 7   :    Select Additional Settings ➢ Temporary Dimensions.
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 Now that you’ve confi gured the temporary dimensions the way you need 
them, you can start using them to manipulate the placement of your door.

1.  Select the door again.

2.  Move the left witness line of the left temporary dimension to the out-
side face of the CMU wall, as shown in Figure   2.68   . 

    F I G U R E     2 . 6 8   :    Moving the witness line to a more appropriate location

3.  As you know, in Revit anything that turns blue can be edited. Click the 
blue dimension that extends from the CMU wall, drag it to the right of 
the elevator shaft, and change it to 1 –0  ( 300  mm) (see Figure   2.69   ).      

    F I G U R E     2 . 6 9   :    Changing the temporary dimension
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 Editing Door Tags

 Let’s concentrate on the tag now. The number contained within the “box” is an 
instance parameter. That means each door in the model will contain a unique
number. When you place a door, this number will be added automatically. Revit
knows not to duplicate this number. As each door is placed, Revit will assign the 
next sequential number to the door. This number, of course, can be changed. 

 Follow along with the next exercise to see how to manipulate the door
number: 

1.  Select the door (or the door tag). 

2.  Pick the number in the door tag.

3.  Change the number to  101 .

4.   With the door still selected, notice that you have fl ip arrows as well. If 
the door isn’t in the orientation you see in the previous fi gures, click
these arrows to fl ip the door.     

5.  Mirror this door and its tag around the building’s horizontal center-
line. Notice the number for the new door is 102.     

 Loading Families

 It would be nice if the seven doors available in the Revit model were all you 
needed. They aren’t, of course. Like most other CAD programs and applications 
that use BIM, Revit doesn’t load every single component into the drawing or 
model. File size is just as much a concern in Revit as it is in AutoCAD. If you 
need a different door, you have to go get it.

1.  On the Architecture tab, click the Door button. 

2.  On the Modify | Place Door tab, click the Load Family button, as 
shown in Figure   2.70   . 

◀

 Most items that are 
added to the Revit
model can be selected 
and fl ipped using the 
same method. Also, 
selecting the items to 
be fl ipped and pressing
the spacebar has the 
same eff ect.

    F I G U R E     2 . 7 0   :    Click Load Family on the Mode panel. 

3.  Find the Doors  directory, navigate to  Double-Flush.rfa  (M_Double-
Flush.rfa ), and click Open.
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4.  Select Double-Flush: 72  × 84  (M_Double-Flush 1830 × 2134) from
the Type Selector.

5.   Place the double doors in the wall, as shown in Figure   2.71   . Click
Modify.

    F I G U R E     2 . 7 1   :    Placing the double doors

▶

 Normally, doors 
automatically fi nd the
center of the wall. But 
to make sure, you can 
type SM . Doing so tells
Revit that you want to
snap to the middle. 

6.  Mirror both doors and tags using the center reference plane. 

7.  Add lavatory doors as shown in Figure   2.72   , keeping all offsets 
1 -0  (300 mm) away from the walls. Use Single-Flush: 36  × 84
(M_Single-Flush 0915 × 2134).

8.  Label them accordingly. 

9.  In the exterior wall that divides the east building from the corridor, 
add a Single Raised Panel With Side Lights: 36  × 84  door cen-
tered on the opening (metric users, use M_Double-Panel 2 1830 × 
2134 mm).

10.  Change the tag to read  100B , as shown in Figure   2.73   .

 You need to add more doors and interior partitions, but they will be best
suited for Chapter   4  , where you can be more accurate. In the meantime, let’s
add some simple openings.
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    F I G U R E     2 . 7 2   :    Adding lavatory doors. You’ll have to renumber the tags.

    F I G U R E     2 . 7 3   :    Adding a new corridor door. If this door isn’t loaded into your model, you have to 
click the Load Family button on the Mode panel of the Modify | Place Door tab.
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 Placing Openings in Your Walls 
 I like to think of openings as doors in a sense. That is, you still need to insert 
something into a wall to create a void. This void can contain casing as well. 

 To add an opening to the model, run through these steps: 

1.  On the Architecture tab, click Component, as shown in Figure   2.74   . 

    F I G U R E     2 . 7 4   :    Clicking Component on the Architecture tab

2.  On the Modify | Place Component tab, click the Load Family button. 

3.  Browse to the  Openings  directory.

4.  Find the fi le called  Passage Opening-Elliptical Arch.rfa
( M_Passage Opening-Elliptical Arch.rfa ), and click Open.

5.  Click the Edit Type button in the Properties dialog, as shown in
Figure   2.75   .

    F I G U R E     2 . 7 5   :    The new opening 
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6.  Click Duplicate in the Type Properties dialog.

7.  In the Name dialog, name the opening  84  × 84  ( 2100  mm × 2100  mm), 
and then click OK. 

8.  Under Dimensions, change Width to 7 –0  (2100  mm).

9.  Click OK. Then press Esc to clear the command.

10.  Zoom into the area shown in Figure   2.75  , and place an Interior – 
6 1⁄8  Partition (2-hr) (Interior – 135 mm Partition (2-hr)) wall as 
shown. This is the wall into which you’ll place the opening.

11.  On the Architecture tab, click Component, and place the opening
into the wall as shown in Figure   2.75  .

 Add two more doors, and you’ll be fi nished with this section.

1.  On the Architecture tab, click Door.

2.  In the Properties dialog, pick Double-Flush: 72  × 84  (M_Double-
Flush 1830 × 2134).

3.  Add the double doors to the ends of the vertical corridor, as shown in 
Figure   2.76   . 

    F I G U R E     2 . 7 6   :    Two new corridor doors 

4.  Label the doors  100C  and  100D .    

 Again, there are many more doors and partitions that you can add to the 
model, but that will have to wait until Chapter   4  . Let’s move on to add some
windows.   
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 Adding Windows 
 Doors, windows, openings…they’re all the same. When you have experience 
adding one, the others are just as easy. 

 The objective of the next procedure is to add some windows to the model. 

1.  On the Architecture tab, click the Window button, as shown in Figure   2.77   .

    F I G U R E     2 . 7 7   :    Adding a window is the same as adding a door.

2.  Select the Fixed: 36  × 72  (M_Fixed 0915 × 1830) window from the
Type Selector, and make sure the Tag On Placement button is active. 

3.  Add the window to the corner of the building, as shown in Figure   2.78   .
Be careful with the placement. If your cursor is toward the exterior of 
the wall, the window will be oriented correctly, and the window tag
will appear on the outside of the wall.

    F I G U R E     2 . 7 8   :    Depending on which side of the wall your cursor is on, you can 
add a window to the correct orientation.
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4.  Add two more windows to the west wall adjacent to the wall in which 
you just put the fi rst window. Use your temporary dimensions to
ensure that you’re placing the windows at the increments shown in
Figure   2.79   . You’ll have to place the windows and then use the tem-
porary dimensions to move them to the proper dimensions in a simi-
lar manner to the fi rst door you placed earlier in this chapter.

    F I G U R E     2 . 7 9   :    Placing the windows in the corner of the building and 
mirroring them

5.  Mirror the windows and tags using the center horizontal reference 
plane (see Figure   2.79  ).

6.  Select one of the placed windows. Notice the temporary dimensions
and the fl ip arrows.

7.  Change the tag to read  A   . (All of the windows are type A.) 

8.  You get a warning stating that you’re changing a type parameter. 
Click Yes.
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 Now that the windows are in place, it’s time to investigate how they’re built by
taking a look at their properties.

 Window Properties 

 Again, just as with doors and openings, you can check the Element Properties to
tweak the unit even further: 

1.  Select one of the windows.

2.   In the Properties dialog, click the Edit Type button, as shown in
Figure   2.80   .

    F I G U R E     2 . 8 0   :    The Edit Type button in the Properties dialog

T I P If you want to change an instance parameter (such as Sill Height) for every
 window in the model, you can. Knowing that an instance parameter applies to only one 
item, instead of picking just one window, you can pick a window, right-click, and choose 
Selec t All Instances. From there, you can change ever y window’s parameters in the 
Properties panel because you had every window selected. 

3.  Scroll down until you see Type Mark. Notice that this value is set to
A. This is the property you changed by typing the value into the tag 
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 Windows are among the most diffi cult items in Revit to use out of the box
without any real customization. In Chapter   16  , you’ll dive into creating custom 
Revit windows. For now, however, remember the lessons learned in this chapter. 
They will go a long way.     

in the model. Window tags read the Type Mark property by default, 
whereas door tags read Mark, which is an instance property. In either
case, Revit works both ways. If you change a tag value in the model,
it changes the parameter value in the tagged object or tagged family
(see Figure   2.81   ).     

    F I G U R E     2 . 8 1   :    Changing a type parameter changes every window of that type. 
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 Are You Experienced?
 Now you can…   

✔    place exterior walls

✔    place interior walls

✔    add reference planes 

✔    join walls 

✔    use the Split command 

✔    edit a cut profi le

✔    add doors 

✔    add openings 

✔    add windows      


